
Quick Reference Guide

THE PRO-STITCHER WORKSPACE

This guide will help you through the learning curve of the user 
interface, fi nding commonly used features, and becoming 

familiar with new features you’ll love using.PREMIUM

Quick-Access 
Toolbar: Butt ons 
shown here are 
always visible. 
You can add 
your favorite 
commands to 
this toolbar.

Help butt ons: Select the Help tab for on-screen indexed and 
hyperlinked help content. Select the Help butt on and then click a 
butt on or tab on the screen for context-sensiti ve help.

Ribbon: The butt ons on the Ribbon change 
according to which tab is selected.

Sidebar: The 
sidebar includes 
butt ons for the 
functi ons ti ed to 
the various Ribbon 
butt ons. The 
Sidebar Tabs relate 
to other aspects of 
the workspace.

Tabs: Select any tab to display its butt ons and functi ons.

Select All

Multi  Select
Zoom to 
Design

Zoom to 
Area

Zoom to 
Actual Size

Zoom the work-
space: Touch the 
plus (+) or minus 
(--) butt ons to 
zoom in or out, 
or use the slider 
bar: slide right to 
zoom in or left  to 
zoom out.

Workspace Toolbar: Butt ons shown 
here are always visible. Only one 
butt on can be selected at a ti me.

Select None

Refresh

Rulers

Design rubber 
band (green)

Design start 
point (green)

Jump (purple dott ed line): not sti tched

Design end 
point (red)

Design bounding 
box (blue)

Pan Scroll 
Bars
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LEARNING PRO-STITCHER PREMIUM
WHERE’S THE USER MANUAL?

Your Pro-Sti tcher came with a Getti  ng Started Guide that includes installati on instructi ons, safety informati on, and troubleshooti ng 
ti ps. The soft ware operati on and reference informati on is available as an on-screen, context-sensiti ve help system and has an indexed 
and hyperlinked reference guide. Both are accessible from within Pro-Sti tcher. This enables you to look up instructi ons related to a 
specifi c functi on while you are using the soft ware.

ACCESSING ON-SCREEN HELP IN PRO-STITCHER

Context-sensiti ve onscreen help: The context sensiti ve help enables you to point to a butt on or functi on within Pro-Sti tcher and 
display a pop-up help window describing just that feature. The informati on is usually more concise than using the Reference Guide. 
If aft er reading the context-sensiti ve help you want more informati on, refer to the Reference Guide.

Reference Guide: The reference guide is structured much like other help systems in Microsoft  Windows-based soft ware. It has a 
table of contents, an index, search capability, and hyperlinks between help topics.

To Do This Select This Then Do This
Display context-sensiti ve 
onscreen help

Select a Pro-Sti tcher tab, butt on, or area on the workspace to display a text box with 
informati on about that functi on.

Access the reference guide Select the reference guide help tab, then select the Help butt on in the Ribbon.

FIND COMMONLY USED FEATURES
General instructi ons: To access the various Pro-Sti tcher Premium functi ons, you will typically select one of the tabs which displays a 
ribbon of butt ons below the tabs. When you select a ribbon butt on, customizati on opti ons for that functi on display in a sidebar along 
the right side of the screen. (If the Sidebar is closed, choose the Open Sidebar arrow butt on at the upper-right corner by the
Pro-Sti tcher workspace.)

To Do This Select This Then Do This
Open, close, or save one or 
more design(s).

File tab Choose Design >  Open, Close > Selected, or Save > Selected from the Ribbon.

Shut down Pro-Sti tcher File tab Choose the File tab, and then choose Shutdown from the Ribbon. From the menu 
choose Shut down to shut down the Pro-Sti tcher tablet and the soft ware; choose 
Reboot to restart the tablet and the soft ware; or Exit to Windows to shut down the 
soft ware but return to the Windows desktop. 

Show or hide the design, the 
bounding box, the area box, 
the rubber band, the jump 
points, start and stop points, 
the grid lines, the scroll bars, 
or the rulers

View tab Choose the items from the Ribbon that you want to display or not.

Duplicate or clear a design Edit tab Choose Duplicate or Clear All from the Ribbon.

Create an area Area tab Choose 2-Corner or Multi -Point from the Ribbon; then fi ne tune on the Sidebar.

Baseline the design 
modifi cati ons

Modify tab Choose Baseline from the Ribbon; you can also assign the Baseline butt on to the 
Quick Access Toolbar.

Rotate, fl ip, or mirror a 
single or grouped design

Modify tab Choose Rotate; choose either Group or Single on the sidebar; then choose from the 
rotate opti ons.



Crop the design relati ve to 
an area

Modify tab Create the area. Choose Crop from the Ribbon, choose Outside or Inside on the 
Sidebar. Then indicate whether to perform a ti eoff  at the jump points (disable the 
Edges butt on) or to sti tch between jump points (select the Edges butt on).

Crop the design based on 
the design’s start and end 
points

Modify tab Move the design’s start and/or end points (Pro-Sti tcher > New Start/End). Then 
choose Crop from the Ribbon and Start-End on the sidebar. Then indicate whether to 
perform a ti eoff  at the jump points (disable the Edges butt on) or to sti tch between 
jump points (select the Edges butt on).

Change the dimensions of 
the design

Modify tab Choose Resize from the Ribbon. Choose Lock to lock the aspect rati o if desired. 
Choose either Width, Height, Original Width, or Original Height on the sidebar; 
then use the Plus (+) and Minus (—) to adjust the dimension.

Skew the design Modify tab Create an area and open a design. Select Modify > Skew to open the Skew sidebar. 
Generally you will use Skew 1 when skewing to a convex area and Skew 2 when 
skewing to a concave area.

Swap the quilti ng start and 
end points

Modify tab Select the Swap butt on.

Repeat designs in the 
workspace

Repeat tab Add or remove design repeats using the Plus (+) and Minus (—) butt ons, or select 
the Fit butt on to have Pro-Sti tcher automati cally calculate the opti mal number of 
repeats both horizontally and verti cally. Add more horizontal or verti cal repeats if 
desired, and then stretch them verti cally and horizontally to fi t them to the area.  

Wrap repeated designs in 
the workspace

Repeat tab Off set rows of repeated designs, or shift  the enti re design window. 

Sti tch perfectly straight lines 
across the quilt

Pro-Sti tcher 
tab

Use Channel Lock to sti tch horizontally or verti cally, or use Move with the Sti tch 
butt on selected to sti tch up, down, left , right, or diagonally.

Quilt a design Pro-Sti tcher 
tab

Select Quilt from the Ribbon. (Make sure the Sti tch butt on is selected in the 
Sidebar.) Then select Run. 

Recover from a thread break 
or running out of bobbin 
thread

Pro-Sti tcher 
tab

Use New Start & End to change the start point of the design to the positi on where 
Pro-Sti tcher needs to resume sti tching.

To Do This Select This Then Do This

SIDEBAR RIBBON BUTTON REFERENCE

Design: Opens a design fi le. Navigate through your 
computer’s fi le system to locate the design fi le you 
want to use. The drop-down menu also shows the 
design fi les you most recently used for quick access. 

Workspace: Opens a workspace fi le. Navigate through 
your computer’s fi le system to locate the workspace 
fi le you want to use. The drop-down menu also shows 
the workspace fi les you most recently used for quick 
access. 

Area: Open an area fi le. Navigate through your 
computer’s fi le system to locate the area fi le you want 
to use. The drop-down menu also shows the area fi les 
you most recently used for quick access. You can have 
only one area open at a ti me. 

Save: Select to save the selected design(s), the 
workspace, or the area. 

Close: Select to close the selected design(s), the 
workspace, or the area. You will be prompted to save 
any objects that have had changes.

Clear All: Select to close everything in the workspace. 
Be sure to save anything you want to keep
before clearing.

Update: Aft er downloading the update to a USB drive, 
insert the drive into the Pro-Sti tcher computer and 
select this butt on to update the Pro-Sti tcher soft ware.

 

Shut Down: Select to exit Pro-Sti tcher. From the 
menu, select Shut Down to quit the soft ware and 
shut down the tablet computer; select Reboot to 
restart both the tablet computer and soft ware; or 
select Exit to Windows to exit the soft ware but 
leave the tablet computer on.

FILE TAB RIBBON BUTTONS



History: Use to show a list of your most recent acti ons 
with Pro-Sti tcher. Select an item on the History list 
to return the design to the state it was when that 
functi on was performed. Or select Clear History to 
clear the enti re design history. 

Undo: Use the Undo butt on to undo the last functi on 
performed. Conti nue selecti ng Undo as needed to get 
the design back to where you want it. 

‘Redo: If you change your mind about the last Undo 
acti on, select the Redo butt on.

Cut: Cuts the selected design(s).

Copy: Copies the selected design(s).

Paste: Pastes the copied design(s), positi oning the 
design start point at the needle positi on (indicated by 
the cross hairs).

Duplicate: Select the design(s) you want to duplicate 
and then choose the Duplicate butt on. If one 
design is selected, only that design is duplicated. If 
multi ple designs are selected, all selected designs are 
duplicated. 

Clear All: Select to close everything in the workspace. 
Be sure to save anything you want to keep before 
clearing.

AREA TAB RIBBON BUTTONS

MODIFY TAB RIBBON BUTTONS

File: Use to open an area fi le you have saved. Navigate 
through your computer’s fi le system to locate the 
area fi le you want to use. The drop-down menu
also shows the area fi les you most recently used for 
quick access. 

Select: Selects the area in the workspace. The area 
turns from a purple line to a green line to indicate 
it is selected. You can then use your fi nger to drag 
and drop it, or select the XForm (Transform) butt on 
and use the transform handles to resize, rotate, or 
repositi on the area.

Clear: Select to clear the current area.

2 Corner: Use to create a 2-corner (rectangular) area. 
Positi on the needle where you want the area to begin 
and select 2 Corner, usually the upper-left  corner of 
the area. Then move the cross hairs to the opposite 
corner of the area and press 2 Corner again. Fine tune 
the dimensions of the area in the Area sidebar.

Multi -Point: Use to create a multi -point (concave or 
convex) area. Positi on the needle where you want 
the area to begin and select Multi -Point. Move the 
needle to the next point along the perimeter of the 
area and select Multi -Point again. Conti nue in this 
manner unti l you have created an area. 

REPEAT TAB RIBBON BUTTONS

Baseline: Use the Baseline butt on to "freeze" the 
modifi cati ons you have made to the design.  Once you 
baseline, all modifi cati ons treat the design as a new 
unaltered design. However, baseline does not save 
the design to your computer.

Rotate: Select the Rotate butt on to open the Rotate 
Sidebar. You can rotate a single design or multi ple 
designs.

Repositi on: Use the Repositi on opti ons to positi on a 
design relati ve to the needle positi on (represented by 
the cross hairs on the screen).

Resize: Select the Resize butt on to open the Resize 
Sidebar. You can adjust the height and width, as well 
as the original height and original width (if the design 
has been rotated). You may also lock the aspect 
rati o so the height and width increase or decrease 
proporti onately.

Crop: Use the Crop functi on in conjuncti on with a 
defi ned area. Aft er a design has been loaded and 
modifi ed as needed, mark an area that represents the 
region to be cropped. Select the Crop butt on to open 
the Crop Sidebar. If the Crop opti ons are not available, 
an area has not yet been defi ned.

Align: Aft er you create an area, use the align opti ons 
to positi on the design within the area. To open the 
Alignment Sidebar, select the Align butt on. Then 
select from the alignment butt on(s) to positi on the 
design within the area.

Skew: Aft er you create an area, use the skew 
opti ons to fi t the design within the area. Any further 
formatti  ng you do to the design will also stretch to the 
limits of the area. The Skew opti ons aren't available 
unti l you defi ne an area and open a design.

Swap: Use this butt on for those ti mes when you want 
to switch the quilti ng start and end points, such as 
when you rotate or fl ip a design and the start point is 
now at the right side of the design. 

EDIT TAB RIBBON BUTTONS

Basic: Provides several opti ons for repeati ng designs 
both verti cally and horizontally. If you have created an 
area, you can also have Pro-Sti tcher determine how 
many repeats will fi t within the area.

Wrap: Provides several opti ons for wrapping, or 
off setti  ng, designs either verti cally or horizontally. 
Most of these opti ons can be done with or without a 
defi ned area. 



TOOLS TAB RIBBON BUTTONS

Half Sti tch: Select to cycle the needle either to the up 
or the down positi on based on the current positi on of 
the needle.

Full Sti tch: Select to cycle the needle a full sti tch to 
the up positi on. If the needle is in the down positi on, 
it will move only a half cycle so it stops in the up 
positi on. Subsequent presses of the butt on, however, 
will cycle a full sti tch, always ending with the needle 
in the up positi on. 

Follow: Select Follow when you want to ensure that 
the cross hairs remain in view when you have zoomed 
into a design. This saves you from having to use Pan to 
fi nd the cross hairs. It is also helpful to enable Follow 
when you sti tch a wide design because you can both 
zoom in on the design and always see what is being 
sti tched on the screen.

Measure: Select to measure distances in a design or 
directly on the quilt. 

Quilt: Select when you are ready to begin quilti ng; 
then select Run. If Verify Before Quilt is enabled 
(Setti  ngs Tab > Advanced > General), Pro-Sti tcher 
displays all of the setti  ngs for you to review. Press 
Proceed to conti nue.

Channel Lock: Select this butt on have Pro-Sti tcher 
sti tch horizontal or verti cal lines that are perfectly 
square with the frame. On the Channel Lock Sidebar, 
choose either the Horizontal or Verti cal butt on and 
begin sti tching.

Move: The Move opti on enables you to move the 
quilti ng machine in any of the 8 directi ons indicated 
by the directi on arrows by pressing that arrow butt on. 
Select the Conti nuous butt on for the machine to 
move conti nuously, select the Sti tch butt on to sti tch 
as you press the arrow butt on, or select both the 
Conti nuous and Sti tch butt ons to sti tch conti nuously. 
Press the Stop butt on that appears to turn off  the 
Conti nuous operati on.

New Start & End: Use this butt on to start quilti ng a 
design from some point other than the design's start 
point. You may need to do this because the thread 
breaks, the bobbin runs out, or you simply want to 
sti tch a specifi c porti on of a design. Similarly, you may 
change the ending point to a point other than the 
design’s original end point.

Record: Pro-Sti tcher can record the movement of 
the quilti ng machine. For example, record your own 
background designs across the width of the quilt. Or 
record your signature so you can quilt your signature 
into your quilts.

Gears: Typically you will engage the Pro-Sti tcher 
motors when using computerized quilti ng and 
disengage them for free-moti on quilti ng. Choose the 
Gears butt on to automati cally engage or disengage the 
motors if you have a Pro-Sti tcher Carriage. If you have 
a carriage with levers, manually raise the levers to 
disengage or lower them to engage the motors. If you 
are going to have Pro-Sti tcher record your sti tching 
(Pro-Sti tcher Tab > Record), disengage the motors for a 
smoother free-moti on quilti ng experience. 

Clear Trace: As Pro-Sti tcher sti tches, the porti on of 
the design that has been sti tched turns to orange on 
the screen. At any ti me you can clear that "tracing" 
by choosing the Clear Trace butt on. If you are in 
the process of sti tching out the design, fi rst select 
the Pause butt on and then Clear Trace. Then press 
Resume to conti nue sti tching.

VIEW TAB RIBBON BUTTONSPRO-STITCHER TAB SIDEBAR BUTTONS
Rulers: Select to hide or show the workspace top
and side rulers. This butt on may be added to the
Quick-Access toolbar to quickly turn the rulers
on or off .

Grid: Select to hide or show the workspace grid. This 
butt on may be added to the Quick-Access toolbar to 
quickly turn the workspace grid on or off .

Scroll: Select to hide or show the bott om and right-
side scroll bars in the workspace. Use the scroll bars 
to pan up and down or left  and right. This butt on may 
be added to the Quick-Access toolbar to quickly turn 
the scroll bars on or off .

Transparency: Select to hide or show the workspace 
lightly below Pro-Sti tcher screen areas beyond the 
main workspace, such as below the ribbon butt ons, 
the sidebar, the status bar, and the toolbars.

Area: Select to hide or show the area box. This butt on 
may be added to the Quick-Access toolbar to quickly 
switch between showing the area box or removing it 
from view.

Design: Select to hide or show the design from the 
workspace. This butt on may be added to the Quick-
Access toolbar.

Bounds: Select to hide or show the bounding box 
around the selected design(s). This butt on may be 
added to the Quick-Access toolbar.

Rubber Band: Select to hide or show the rubber band 
around the selected design(s). The rubber band shows 
the smallest area required by the enti re design.

Jumps: Select to hide or show the sti tching path 
between jump points, or places where you need to 
stop sti tching, ti e off  your thread, and then conti nue 
sti tching at the next start point. This butt on may be 
added to the Quick-Access toolbar.

Start End: Select to hide or show the quilti ng start 
and end points in a design. This butt on may be added 
to the Quick-Access toolbar.

Art & Sti tch: Select to pass the selected design(s) to 
Art & Sti tch, select the Tools tab and then select the 
Art & Sti tch butt on. If Art & Sti tch is open and has 
been licensed, the design will open in Art & Sti tch. 
If Art & Sti tch has not yet been licensed, a licensing 
screen will appear for entering license informati on.



Display: Select to turn on or off  Touch Mode, 
customize the Quick-Access Toolbar, and
confi gure Pro-Sti tcher so it works best with
your tablet computer.

Defaults: Select to set the Nudge increment and
Auto Jump threshold defaults.

Speed: Select to control how fast the Pro-Sti tcher 
carriage will move through the quilti ng design. 
Because the quilti ng machine regulates its own speed 
to maintain a specifi c sti tches-per-inch setti  ng, the 
speed does not directly set the needle speed.
Instead it sets how fast the machine moves across
the frame system.

Auto Jump: Select to temporarily override the Auto 
Jump default. Touch the Plus Sign (+) to increase 
or Minus Sign (–) to decrease the sti tches per inch. 
Alternately, touch the number box and type a value 
directly and press Enter.

Sti tches per Inch: Select to set the sti tches per inch. 
Touch the Plus Sign (+) to increase or Minus Sign (–)
to decrease the length of Auto Jump. Alternately, 
touch the number box and type a value directly and 
press Enter.

Tieoff s: Select to specify your preferred method for 
how and when Pro-Sti tcher performs ti eoff s. 

Pullup: Select to specify your preferred method for 
how Pro-Sti tcher performs pullups.

Pause Delay: Select to specify your preferences for 
how Pro-Sti tcher pauses for you to trim threads aft er 
starti ng to sti ch the design. Specify either the number 
of seconds it will pause for you to cut your threads or 
how many inches it will sti tch before pausing for you 
to cut the threads.

Advanced: Setti  ngs that are not likely to be used oft en 
can be found by selecti ng the Advanced butt on. Some 
of these setti  ngs include communicati ons between 
the quilti ng machine and the Pro-Sti tcher, 
Simulati on mode, and other opti ons.

Help: Select to open the on-screen Pro-Sti tcher 
reference guide. It has a table of contents, an index, 
search capability, and hyperlinks between help topics.

About: Select to open the About box. This is where 
you will fi nd the Pro-Sti tcher version number, as well 
as the key code you’ll need if you decide to purchase 
any digital designs that are encrypted.

SETTINGS TAB RIBBON BUTTONS HELP TAB RIBBON BUTTONS
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